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Application 12.0.0.91
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There are some exciting new features in the new version 12 release.
Some of these changes include:
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- 64-bit application

- Part Dimensioning

- Direct Part Editing

- Dimensioned Reports

- Polyshape Part added

- Import DXF as Border

- QR Codes on Labels

- Animated folding buttons
- New Materials added

- CNC Config Editor for EzyNest
- New reports

- And more!

Videos, Updates and New Features Information

The ShapeMaster Team regularly creates new videos for our YouTube Channel.

These videos can cover many different areas within our software from creating new
buttons to modifying machining on a pipe chase cutout. If you have an area you would like
more information on, please send us an email request and we will try to get one created
for you.

www.youtube.com/user/CabMasterSoftware

We also have a Facebook page to provide you with the most up to date information and
news on upcoming videos, software updates and new features. Be sure to follow us.

www.facebook.com/ShapeMasterSoftware
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26th August 2024

New V12 FEATURES

Performance Enhancements

We have improved the performance of ShapeMaster Software in many areas so the overall feel
and use of this new product should be noticeably quicker when pressing F8 etc. We have also
reduced the Memory Load for larger drawings.

New: 64-bit AMSCloud build available

Previous versions of ShapeMaster Software had 32-bit application architecture, which means that
it could only use up to 4GB of memory. Version 12 application is now 64-bit architecture and can
now use up to 16 billion GB of memory. This gives us an insane amount of memory space and
helps stabilize and optimize how ShapeMaster Software runs on your system.

64-Bit Application

0. % e

New: Machine View now has button to open CNC-Config editor.

We have written a new add-on that lets you configure EzyNest/EnRoute fully from within
ShapeMaster Software. In the Machining tab of ShapeMaster, there is a new button called
“Config”. This will open our new add-on where you can configure your settings for
EzyNest/EnRoute, from the CNC Driver, to Tooling and Layers, and Strategies. You don't have to
leave ShapeMaster to configure these anymore.

. NZ

v1230

) CNC Config

Tools Library 21 tools defined

.,}‘
-

Strategy Configuration 43 strategies defined

{ b«

Define Layers 20 layers defined
g;: Nesting Settings
=

Machine Setup LedaKDT-Delta -> RArcs

Miscellaneous Settings

e o

EzyNest Location:  EAllMasterSoftware\EzyNest231

Selected ATP: CabMasterPro 2400x1200x16 HMR.atp

SetLocation of EzyNest SelectATP ﬁ- Exit
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Plugins: Ability to use multiple Plugin tables along with a
Configuration Manager

The Setup > Configure My Extensions page allows you to have multiple 'Plugin' tables and to
configure the My Extensions > Plug-Ins page by selecting as many entries as required from
multiple tables.

A Plugin is an external control that integrates with the ShapeMaster interface, with which the user
can interact with, and can be run from the My Extensions > Plug-Ins page at Drawing level.

Plugln tables can be packaged and be downloaded, however, the setup of these tables may
require assistance from ShapeMaster Support.

Shapelist

[£53 Job Details

55 Setup
General
Output TOOG
Machining
Defaults
Slots and Toggles Add
Holes

My Extensions Configuration
Enable Table Entry Name

4

Export CSV - | ToogSoft Export Remove

4

MaxCut Export CSV + | MaxCut Export Remove

Corner Clean

Z Brackets

Display Edit : Plugin Table
Local Properties

Save Configuration

.. Restore from Saved .
Pricing

Report
=2 Configure My Extensions

New: button for generating only missing images

You can now generate only the missing images for your palette when adding new shapes to your
catalog. This makes it much faster to get back into production. Just go to File / Options / Images
and press the “Generate Missing Images” button.

Options
General Gallery
Gallery Style: Machinin - Background:
Developer ? |:|
Tooltip Style: Machinin - Background:
| Images g |:|
[C] Show captions
File Locations
Support Applications Picker
Preview Style:  Machining +  Background: I:l
Advanced
Regenerate All Images Generate Missing Images |

OK Cancel Help
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New: Add LibraryForce setting to general options page

We have added the option to select the default library when starting ShapeMaster Software by
default. This will ensure the correct library is loaded on each startup. This option can be found
under File / Options / General page.

| General On New Drawing
Developer Show drawing properties
Images Use Library:| ShapeMaster-2 =

New: Masking the previously used activation code for cloud2

In the latest version, it no longer displays the previously used activation code for cloud2 acquires.
If you have one encrypted and remembered in the registry, then the dialog looks like this:

AMS Cloud Activation (f x
Product requires activation... please enter your License here or copy to
clipboard and press Paste button...

o

Paste License

Account Code: ABC12

Account Mame: ABC Kitchens for Dave

Email:

Activate Cancel

New: Drawings get Compressed on Save

All drawings now automatically get compressed when saving. This reduces the size of drawings
saved on your computer, therefore allowing for more drawings to be saved and reducing required
size of total backups.
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New: ShapeMaster now includes Part dimensioning and
detailing.
We have included dimensioning and detailing via the new breadcrumb bar in ShapeMaster V12.

Firstly, add your part to the list (press F12)
Then select your part in the breadcrumb bar as per image below.

File Home
3 Cut Library: ShapeMaster-2 @
52 Copy Type: [&ll Types] = | [&ll Sub-Types]

Shape

" Duplicate = Shape: Block Wrap Taol

Clipboard Shape Selection

ShapeMaster-2 ~ # x

4 Shape
[~ Comer 2: Block Wrap

L . W |

Then you can add dimensions (horizontal, vertical and angular) to the part, as well as text labels
and text boxes to the current part.
These details will be included in reports that display images. E.G. ShapelList reports.

! 700.0 ‘
| \

| , 175.0 , 250.0 , 175.0 , ‘

Noted here

0oof
8108
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New: ShapeMaster V12 now includes direct Part Editing.

We have included a machine editor via the new breadcrumb bar in ShapeMaster V12.

Firstly, add your part to the list (press F12)

Then select your part in the breadcrumb bar, then select the section of that part.

H O -

Current ltem
File Home Editor
N A = ]
Select Paste Label  Text Picture
| | Box
Clipboard

ShapelList »* Page 1 * 1: Block Wrap

Annotations

AShapel

39, -

Dimension Angular
Dimension

AShapel
AShape3

Press the Unlock button,then you can edit the machining of this section of the part directly.
You can curve edges, add a rectangle, circle, drill hole or gang of drill holes and more. As well as
editing the existing shape. This is done per section of each shape.

700.0

250.0

) 175.0 ‘ |
T 1

1
|
| ) 175.0 ‘
T T
® o | |

Noted here
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g'10%

RN ——
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New: checkbox for updating translations files

You can now enable “Update file with unmatched text” for translations. This updates the
translation file with any new pages or text that haven't previously been used.

This can be found under File / Options or (F10). Translations are a fantastic way to personalize
the terminology within ShapeMaster Software. You can literally change any word to something
different. If you're not familiar with it, please speak to our Support Team.

Options

| General
Developer
Images
File Locations
Support Applications

Advanced

On New Drawing

Show drawing properties
Use Library: ShapeMaster-2
Automatic Updates

Check for updates

Check announcements

Language

<no translation:

[ Partial translations

|Update file with unmatched text

Automatic Saves

[ Save every | O minutes

Length Uinits
(®) mm (Crem i) metres
'eyal-y A2 0234

First dimension iz height
Pages and Printing
Fage size: | <from printer:
K |41 2mm | Y (2
Force landscape
Cloud Licensing

Release | [ Long timeout

QK Cancel

S0mm

Infa

Help

New: ShapeMaster Advanced Options added.

Under File / Options, there are 2 new pages called “Support Applications” and “"Advanced”

The Support Applications page lets you select the EzyNest/EnRoute version you are running,
where the Advanced page lets you select things like printing line thickness and export format etc.

General

Developer

Images

File Locations
Support Applications

| dvanced

Interfface
[_] Page Properties in Home Ribbon
Machining Exparts
Format: | XML file {default)
Ovenide extension: et
Printing
Minimum line width: 0

3D Graphics
Lighting options:
Reflect Specular
Full quality while moving
Custom shape side textures
Custom shape shadows
Contrast: 50
Brightness: | 75

.
L

-
L

3D card information

New: Additional Materials added.

We have now included the materials of Alcotex, Trespa and Alucoil for your use.
These materials can all be selected from the Job Details / Materials page.
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26th August 2024
New: Materials 2nd face added.

We have also added the ability to specify the 2nd face color of Trespa materials.
This will let you have different colors from the front to back face of your parts as required.

Shapell

© o s
Job Settings Datasource SM-Trespa M ﬂRE SIPA
& Materials Series Lumen -
g {S:.:Pttucpades Thickness 10mm M
£ My Extensions
10mm Qceania Blue M _
Thickness - 10mm { Fold : } TRESPA
Grained ©y
L2264 Refresh
Finish Diffuse i
Sheet Size X 1860mm M
Sheet Size ¥ 3650mm -
Reverse Colour ) As Front Face [ Select as RGB
Rusty Red - I

New: Polyshape Part.

We have added a new part called Polyshape.

This part lets you create an asymmetric border, or import a DXF as a border, add in slots, holes,
routes and cutouts as required.

This part will let you create a completely different type of shape with ShapeMaster.
Polyshape 2 Shape Tool

> O %
& shape [ Polyshape 2
& Settings
Border Polyshape 2
Border ct'd ity 1 Name Polyshape 2
Circles
Route l o=
Cutout1 Visibility

Cutout?

[_] Show Points
Optiens

Circle
() Dll
Route

Cutout {Coordinates)
) Cutout (Size & Position)

Border Style
() Standard i®) Advanced ) DXF
Radius @ Arcs ) Fillet EEE
View .§
-
®2D ) Machining |
) Wire () Texture ..

&
fetetetets

el
!
e

b
g

New: Play button added to all folding parts.

We have an automatic “play” button that slowly folds the part from flat to completely folded and
back again as an animated option. These buttons are found next to the 2d / 3D buttons.
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New: Reports updated

We have updated the reports to work in imperial correctly. Added options to include or not include
images for ShaeplList 1 and 2 column reports.
Reports also show dimensions and part edits.

Name Block Wrap 5 Piece NZe -V
Width x Length 1981 3/ 16mm x 1086 31/ 64mm
Part ID 1
Quantity 1
Material 3mm Gold Metallic
Thickness 3mm
Comment -
AN 2/ N
Name Rectangle Blank
N r——r w1 Width x Length 1310mm x 593 25/ 64mm
Part ID 4
Quantity 1
Material Imm Gold Metallic
A Thickness 3mm
Comment

New: QR Codes on Labels

You can create a custom layout for QR Codes on your part labels.
You can also select an image to display on your labels.

ShapeMasterAdd

[£5) Job Details QR

£ Setup

[ QR Codes 1 Text () Custom

& OR Format
Label Images =
5 e ShapeMaster
Custom

Job Mumber - -
Shape Mame - -
Part I1d - -
<null= - -
<null - =
enull - -
<null= - -
] Units (Dimensions)
Sample: Job1_Rectangle_ 020304
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New: Local Properties - blank variables.

We have added 25 ‘blank’ variables that can get used with custom tables. This lets you write your
own parametric machining table that can have a local property assigned so you can specify a
value such as a dimension or quantity or offset from within the drawing properties or at part
level.

ShapeMasterAdd

g JScElTquetalls Local : Definition
General o1 x1
i Output 02 2
[ Machining 8 -
Defaults O =
Slots and Toggles 14
Holes 05 i
Corner Clean
Z Brackets s X6
Display 7 W7
=3 Lo.clal Properties Ce =
Pricing
Report 9 ®9
Configure My Extensions 10 <10
[E3 OR Codes
= Wy Extensicns o x11
12 x12

New: Override Text display

You can now override the part name with your own text, whilst still keeping the part name.
This lets you display your own text, size, angle and offset on each section of a part.

800Panel Shape ~ O x
& Shape Holes =
Settings [0 Fixing Holes (] Offset " Reset |
g ;E:;::; {0 Fixing Holes (Tabs) =
[ o1_Bottom:Flap [ Fixing Hole Sets | Reset | |
) ol_LeftFlap ) Weep Holes )
E Zl:ifph;gzp (] Fixing Brackets | Reset |
Cutout
0 Reference
[ Bt | @A OB oc oD OE
Custom
u] [ Onigin (1) | <Select> E
] | Origin (1) | <Select> .
[u] | Origin (1) | <Select> -
| Refresh |
Overide  Ovemde Test
1 - oM
- Omm 4 Omm
G 1
Size 7 - | Reset |
Display
@] | Reset |
Comer Clean
O Include Orm
| Reset |
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New: Add fold lines - fixed positions

26th August 2024

We have added the ability to include manual fold lines at a fixed position per shape.
This will give you the ability to add a line from start point X & Y to end point X & Y on each part.

Extra Fold Pro

X
[ Include Start Omm
End Omm

Type

Fold

Section Upper-3 : BExra Fold - Fixed Position

New: Import DXF as Border for Rectangle and Rectangle Multi.

You can now import a 2D DXF file as your border for the Rectangle and Rectangle Multi parts.

This lets you import any shape, but you can’t always add flats to the parts. But you can add
holes, routes and slots in machine editor.

£ Shape
% Settings
Flaps
Z Brackets
Options

Rectangle Standard Shape Tool

Rectangle Standard
Gty 1

None -
50deg
Omm

Aaps
Z Brackets
Fold (Relative Position)
Fold (Fixed Position)

View

®20 O Machining
O Wire O Texture
Import DXF

Use DXF as Border

Rectangle Standard

Name Rectangle Standard

Clean

@A OB

Omm
$0deg

Nore -

Nore -
90deg
Omm

Edge Labels

Select DXF

Tabie \DXFCL

105.0XF

Offsets

New: Grain arrow indicators.

You can now control the size of the grain arrows, so they don’t get too large and overtake your

part images.
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New: Specify corner angle or length.

You can specify the angle of a corner cutout instead of just a length as in previous versions.
This will give you more accuracy when designing parts in the future. In the example below, we
have an angle at 25deg over 100mm.

Rectangle Standard Shape Tool v O x
& Shepe i Rectangle Standard
& Settings
Flaps Rectangle Standard
ZBrackets ay 1 Name Rectangle Standard
Options
[ Notes |
H £00mm W 00mm | Shape |
65deg S0deg
| Reset | 100mm Omm | Reset |
214 5mm LW TRW Omm
Z5deg TLH TRH 90deg
None - H None ~ | Offsets |
w | Cuve |
| layer |
Nore - None -
90deg BLH BrH | deg
Omm BLW BRW Omm
| Reset | Onm Omm | Resat |
90deg Sldeg
| Qean | | Edge Labels |
| Fold (Relative Position) | (&1 OB oc
| Fold (Fixed Position) |
View
®20 © Machining
O Wire O Texture T —
Import DXF
[ Use DXF as Border
[ Select DXF |
E\AtMasterSoftware \ShapeMaster\/12\ Tabie\ DXFCLtOuts | Samples | 105.DXF
-
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